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CHAPTER-1 
FUNDAMENTALS OF COMPUTERS 

OBJECTIVES OF THIS LESSON 

This lesson is aimed to make you understand the following about a computer system: 

 Historical evolution of computers and computer generations 
 Working model of a digital computer and functions of a digital computer 
 Basic characteristics of digital computer  
 Types of computers                            
 Classification of digital computers- 
 Similarities between human beings and computer system 

STRUCTURE OF THIS LESSON 

1.1 Introduction 

1.2 Historical Evolution of Computers 
1.3 Computer Generations  

1.3.1 First Generation (1946-1959) 
1.3.2 Second Generation (1959-1965) 
1.3.3 Third Generation (1965-1971) 
1.3.4 Fourth Generation (1971-1985) 
1.3.5 Fifth Generation (Beyond 1985 and Till-Date) 

1.4 Model of a Digital Computer 

1.5 Functioning of a Digital Computer 

1.6 Characteristics of Digital Computer  

1.7 Classification of Computers                            

1.7.1 Analog Computers 
1.7.2 Digital Computers 
1.7.3 Hybrid Computers 
1.7.4 Difference between Analog and Digital Computers 

1.8 Classification of Digital Computers 

1.8.1 Supercomputer 
1.8.2 Mainframe Computers 
1.8.3 Minicomputers 
1.8.4 Microcomputers and its Types 

1.9 Human Beings Vs Computer Systems 

Summary of the Lesson 
Self Assessment Questions and Exercises 

1.1 INTRODUCTION 

Let us begin with the word ‘compute’, which means ‘to calculate’. We all are familiar with 
calculations in our day to day life. We apply mathematical operations like addition, subtraction, 
multiplication, etc. and many other formulae for calculations. Simpler calculations take less time but 
complex calculations take much longer time. Another factor is accuracy in calculations. So man 
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Basics of Computer 3 

Dark Age (5000 B.C. - 1890 A.D.) 

In this age all the computing devices were manual-mechanical in nature and all the earliest data 
processing equipment were all manual-mechanical devices. We refer to the era when these machines 
were used exclusively as the Dark Ages of data processing. This age introduced several devices such 
as Abacus, Napier’s bones, Pascal’s Calculator, etc. 

Middle Age (1890-1944) 

In the Middle Age, all computing devices were electro-mechanical in nature. In other words, these 
worked mechanically with the help of electricity. Examples include Hollerith’s Tabulating Machine, 
Atanasoff Berry Computer (ABC), etc. 

Modern Age (Since 1944) 

Computers changed over time; they improved in speed, power  and efficiency. Those changes  are  
recognized  as  a  progression  of generations  of  discoveries,  each  characterized   by   specific 
developments. 

Mark I (1944) 

Howard H. Aiken of Harvard University in 1937 designed a machine that could automatically 
perform a sequence of arithmetic operations and it was completed in 1944. It was named Mark I. It 
was an electromechanical (relay) device, like the calculators which preceded it.  

1.3 COMPUTER GENERATIONS 

Each generation of computers is characterized by major technological development that 
fundamentally changed the way computers operate, resulting in increasingly smaller, cheaper, and 
more powerful and more efficient and reliable devices. Read about each generation and the 
developments that led to the current devices that we use today. 

The term generation indicates the type of technology used in the computer construction. As new 
technology was emerging, it was being used in the making of computer. The new technology 
improved the speed, accuracy and storage capacity of the computers. Different technologies have 
been used for computers in different times. 

Therefore, computers can be divided into five generations depending upon the technologies used. 
These are: 

1. First Generation (1946 – 1959) 

2. Second Generation (1959 – 1965) 

3. Third Generation (1965 – 1971) 

4. Fourth Generation (1971- 1985) 

5. Fifth Generation (1985 onwards) 

1.3.1 First Generation (1946-1959) 

All subsequent computers after Mark I were all electronic. The early first-generation computers were 
powered by thousands of vacuum tubes. The first computers used vacuum tubes for circuitry and 
magnetic drums for memory, and were often enormous, taking up entire rooms. A magnetic drum, 
also referred to as drum, is a metal cylinder coated with magnetic iron-oxide material on which data 
and programs can be stored. Magnetic drums were once use as a primary storage device but have 
since been implemented as auxiliary storage devices. 

Remarks 
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Basics of Computer 5 

The first computers of this generation were developed for the atomic energy industry. 

Characteristics of Second Generation 

 Transistors 

 Magnetic-core storage 

 Magnetic tape and magnetic disk for external storage 

 Punched cards and magnetic tape for input 

 Punched cards and paper for output 

 High-level languages- FORTRAN, COBOL, PL/I, BASIC and others 

 Human operators to handle cards 

 Examples : Honeywell 200-, 400-, 800-series, IBM 7070/7080, CDC 1604, Burrough B5000 
series, etc. 

1.3.3 Third Generation (1965-1971) 

During this time integrated circuits with transistors, resistors, and capacitors were etched onto a piece 
of silicon. This reduced the price and size of computers, adding to a general trend in the computer 
industry of miniaturization. The development of the integrated circuit was the hallmark of the third 
generation of computers. Transistors were miniaturized and placed on silicon chips, called 
semiconductors, which drastically increased the speed and efficiency of computers. 

 
Figure 1.4: Integrated Circuits 

Characteristics of Third Generation 

 Integrated circuits 

 Improved disk storage 

 Monitors and keyboards for input and output 

 More high-level languages, including RPG and Pascal 

 First complete operating system meant less involvement for human operators 

 Family of computers introduced allowing compatibility 

 Minicomputers used commercially 

 Examples:  IBM  System/360,   IBM   System/370,   Burrough 5700/6700, PDP-8 Series, 
PDP-11 Series, etc.  

1.3.4 Fourth Generation (1971-1985) 

The microprocessor brought the fourth generation of computers, as thousands of integrated circuits 
we rebuilt onto a single silicon chip. A silicon chip contained a CPU. In the world of personal 
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6 Fundamentals of Computers 

computers, the terms microprocessor and CPU are used interchangeably. At the heart of all personal 
computers and most workstations sits a microprocessor.  

 
Figure 1.5: Microprocessor 

Microprocessors also control the logic of almost all digital devices, from clock radios to fuel-injection 
systems for automobiles. 

Three basic characteristics differentiate microprocessors: 

 Instruction Set: The set of instructions that the microprocessor can execute. 

 Bandwidth: The number of bits processed in a single instruction. 

 Clock Speed: Given in megahertz (MHz), the clock speed determines how many instructions 
per second the processor can execute. 

Characteristics of Fourth Generation 

 LSI and VLSI 

 Magnetic disk most common external storage 

 Introduction of microcomputers 

 Fourth-generation languages (4GLs) emerged and application software for microcomputers 
became popular 

 Microcomputers used - Compaq Deskpro 386 

 Typical examples : Burroughs B7700 and HP 3000 minicomputers 

1.3.5 Fifth Generation (Beyond 1985 and till-date) 

The changes that have occurred since 1985 are plentiful. Computers have got tinier, more reliable, 
and many times faster. Computers are mostly built using components from many different 
corporations.  

Computers have become more and more online orientated in modern times, especially with the 
development of the World Wide Web. Popular companies like Google and Yahoo! were started 
because of the internet.   

Fifth generation computing devices, based on artificial intelligence, are still in development, though 
there are some applications, such as voice recognition, that are being used today. Artificial 
Intelligence is the branch of computer science concerned with making computers behave like humans. 
The term was coined in 1956 by John McCarthy at the Massachusetts Institute of Technology.  

Characteristics of Fifth Generation 

 Development of true artificial intelligence 

 Development of Natural Language Processing 
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Basics of Computer 9 

                   
(a) Mid Tower CPU      (b) Vertical CPU 

Fig. 1.8: Few Popular CPU Shapes 

It has the following three sub-units: 

i) Primary Storage Unit (or Memory Unit) 

ii) Arithmetic & Logic Unit (ALU) 

iii) Control Unit 

a) Primary Storage Unit 

We are already aware that the computer is capable of storing data/instruction/information into it. 
Where does the data get stored?  The answer to this question is the memory unit. Memory is a part of 
the microcomputer that holds data for processing, instructions for processing the data and information 
i.e. processed data.  

As we  have  different types of data to be  stored,  this  memory  unit  has  four  major logical areas, 
which are not shown in the figure to avoid complexity. 

i) Input Storage Area  

The input data does not straight away go to the processor. It is first stored in this area till the 
processor asks for it.  

ii) Working Storage Area 

‘Working storage area’ is like a sheet of scratch paper. When the data is being processed, there are  
some  intermediate results that are not required as output but are required to obtain the output. Such 
results are stored in working storage area. 

iii) Output Storage Area 

The final output is not taken by the output devices immediately but is stored in memory till the output 
device is ready to receive it. Thus an ‘output storage area’ holds the finished results of the processing 
operations until they are released on the output device. 

iv) Program Storage Area 

In addition to above, the primary storage also contains a ‘program storage area’. The instructions for 
data manipulation are stored in this area. 

b) Arithmetic & Logic Unit (ALU) 

This unit is capable of performing arithmetic operations and logical operations on the data stored in 
storage area. The basic arithmetic and logical operations include addition, subtraction, multiplication, 

Remarks 



10 Fundamentals of Computers 

division, ORing, ANDing, NOT (complementing), increment, decrement, shifting, clearing 
operations, etc. The data is transferred to ALU for processing and the intermediate results and final 
results are transferred to the storage area. 

c) Control Unit 

This unit controls the  operation  of  each  unit  of  computer system by issuing control signals on  the  
basis  of  instructions provided to the computer  as  a  program.  So this unit can be called the central 
nervous system of the computer. This unit generates timing and control signals necessary for 
execution of instructions. It provides status, control and timing signals necessary for the operation of 
other parts of the CPU, memory, and I/O devices. It controls the entire operation of the computer. It is 
actually the control section of the CPU, which acts as the brain of a computer. 

III.  Output Unit 

The result generated by CPU is either transferred directly or from the output area of the memory to 
the output devices like visual display units (VDU) or printers, etc. 

Mass Storage Devices 

The primary storage area of the computer is limited in size and is expensive.  Only, the frequently 
required instructions are stored in it. To supplement this limited memory, we use auxiliary or 
secondary storage devices like magnetic tapes and disks.  The data can be transferred to/from these 
devices by the processor at a very fast speed. But as compared to primary storage, secondary storage 
is slow. But the advantage of secondary storage devices is that apart from being cheap, they are 
transferable which primary storage is not. There is no limit to secondary storage memory.  This can 
be compared to human beings who use a note-book or pocket-diary to store the notes to supplement 
the brain. 

1.6 CHARACTERISTICS OF DIGITAL COMPUTER 

Now-a-days computer is playing a main role in everyday life it has become the need of people just 
like television, telephone or other electronic devices at home. It solves the human problems very 
quickly as well as accurately. The important characteristics of a computer are described below: 

1. Speed 

2. Arithmetical and Logical Operations 

3. Accuracy 

4. Reliability 

5. Storage 

6. Retrieving data and programs 

7. Automation 

8. Versatility 

9. Communications 

10. Diligence 

11. No Feelings 

12. Consistency 

13. Precision 
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1.7 CLASSIFICATION OF COMPUTERS 

Though in general we use digital computers, however, present day computers may be classified into 
three categories: 

 Analog 

 Digital 

 Hybrid 

1.7.1 Analog Computers 

Analog computers are computers which work on the basis of continuous measurement of physical 
quantities, e.g. pressure, voltage, current, temperature, current, length, etc. We can quote a number of 
instruments that work on the principles of analog computers.  

Limitations of Analog Computers 

 These don’t have logical facilities afforded by programming 

 Don’t have the ability to store data in large quantities 

 Cost of implementation of computation is very high 

Examples : Thermometer, Speedometer, Wall-clock, Voltmeter, Ammeter, etc. 

1.7.2 Digital Computers 

Digital computers are computers which represent data in terms of discrete number and processes data 
using the standard arithmetic operations. These computers directly operate on numbers and produce 
precise results. These are used in a unlimited number of applications. The basic differences between 
analog and digital computers are listed in Table No. 1.1. 

We will be concerned with digital computers only because of the following reasons : 

 The tasks that can be done on analog computers can also be done on digital computers while 
the reverse is not true. 

 To understand the calculations made by an analog computer, some mathematical background 
is necessary, whereas digital computer can be used and understood without much 
mathematical background. 

 The digital computer is used extensively in many areas of application. 

1.7.3 Hybrid Computers 

Design features of Analog and Digital computers can be combined to create a Hybrid Computer. Such 
computers are used for special applications only. Examples of such computers include: 

 Chemical Process Control 

 Patient Monitoring System 

 Electronic Calculating Scale 

 Missile Guidance Computer 

 Flight Simulators For Training Air-plane Pilots 

 Petroleum Distillation Monitoring Systems 
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12 Fundamentals of Computers 

1.7.4 Difference between Analog and Digital Computers 

Table  1.1 : Analog Vs. Digital Computer 

S.No  Analog Computers Digital Computers 

1. Represent continuous measurement 
of physical quantities e.g. rotation, 
voltage, temperature, etc. 

Represent numbers by discrete coded 
patterns  

2. Accuracy is quite limited Unlimited accuracy 

3. Represent physical or mathematical 
quantities 

Represent numbers, letters and other 
symbols 

4. Data-storage scattered in various 
non-interchangeable devices 

Data-storage concentrated in space, 
interchangeable and unlimited in 
duration 

5. Distinct elements used for each 
operation 

Identical elements used in sequence  

6. Sets up analogy of problem Breaks down problem into arithmetic 
operations 

7. Best-suited to represent measurable 
quantities and simulate response of 
physical systems by mathematical 
analogies 

Best suited to handle discrete random 
processes, statistical data, and numerical 
problems of business and scientific 
nature 

8. Serves as model and mirrors relations 
of actual system 

Digital computer compounds arithmetic 
data, unrelated to system it represents 

9. Operations usually carried out in 
real-time of physical system 

Time of operations usually does not 
correspond to  real-time. 

10. Relatively few devices used and 
easier programming 

Many devices needed and difficult 
programming 

11. Basic operation performed by 
relatively few ‘single-purpose’ 
devices (integrators, multipliers, 
magnitude-comparators, etc. 

Operation performed by relatively many 
interchangeable arithmetic devices such 
as adders, registers, accumulators, etc. 

1.8 CLASSIFICATION OF DIGITAL COMPUTERS 

There is a wide variety of computers in the market today which differ in terms of physical size, price, 
capacity, and  performance.  The variety is so wide that it is sometimes difficult to see those elements 
that are shared by many computers and those elements that tend to differ among computers. 

Depending upon their speed and memory size, computers are classified into following four main 
groups. 

1. Supercomputer 

2. Mainframe computer 
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3. Mini computer 

4. Microcomputer 

This classification implies differences between classes between in one or more characteristics.  In the 
1960s, before the microcomputer, there was a clear-cut distinction between minicomputers and 
mainframes. The most  important  characteristics that could be used to differentiate the  two  types  of  
computers were : 

 Speed 

 Instruction sizes 

 Number of CPU registers 

 Word Length 

 Main Memory Size 

 Complexity of I/O modules 

 Operating System Complexity 

 Physical size 

 Cost 

 Virtual address space 

 Secondary Memory Size 

 Degree of Multiprogramming 

1.8.1 Supercomputer 

Supercomputer is the most powerful and fastest, and also very expensive. It was developed in 1980s. 
It is used to process large amount of data and to solve the complicated scientific problems. It can 
perform more than one trillions calculations per second. It has large number of processors connected 
parallel. So parallel processing is done in this computer. In a single supercomputer thousands of users 
can be connected at the same time and the supercomputer handles the work of each user separately.  

Supercomputers are mainly used for: 

 Weather forecasting. 

 Nuclear energy research. 

 Aircraft design. 

 Automotive design. 

 To control industrial units. 

A supercomputer is shown in Fig. 1.9. 
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16 Fundamentals of Computers 

 HP 9000 series 800 (a Supermini) built around HP’s VLSI RISC Processor 

 HCL Magnum built around 68030 and 68040 CPUs 

 IBM AS/400/B60 (installed in 1988) 

 DEC’s VAX 8842 (installed in 1988) 

 Wipro LandMark 860 (a Supermini) built around Intel’s 64-bit RISC processor i860 CPU, 
and so on. 

The capabilities of a minicomputer are between mainframe and personal computer. These computers 
are also known as midrange computers. 

The minicomputers are used in business, education and many other government departments. 
Although some minicomputers are designed for a single user but most are designed to handle multiple 
terminals. Minicomputers are commonly used as servers in network environment and hundreds of 
personal computers can be connected to the network with a minicomputer acting as server like 
mainframes, minicomputers are used as web servers. Single user minicomputers are used for 
sophisticated design tasks. 

The first minicomputer was introduced in the mid-1960s by Digital Equipment Corporation (DEC). 
After this IBM Corporation (AS/400 computers) Data General Corporation and Prime Computer also 
designed the mini computers. 

1.8.4 Microcomputers and its Types 

The microcomputers are also known as personal computers or simply PCs. Microprocessor is used in 
this type of computer. These are very small in size and cost. The IBM’s first microcomputer was 
designed in 1981 and was named as IBM-PC. After this many computer hardware companies copied 
the design of IBM-PC. The term “PC-compatible” refers any personal computer based on the original 
IBM personal computer design. 

On the basis of cost and performance, personal computers can be classified as : 

 Personal Computer (PC) 

 Personal Computer with Extended Technology (PC/XT) 

 Personal Computer with Advanced  Technology (PC/AT) 

 Super AT or Super Micro 

Personal Computer (PC) 

PC is the simplest and cheapest type of personal computer. It uses Intel 8086/8088 as CPU, 640 KB 
RAM, 8KB ROM and normally two floppy disk drives. One of the drives is normally meant for 
holding bootable floppy diskette and the second one is used for holding the application package as 
well as for secondary storage. This type of computer does not contain any hard-disk. It is  a single-
user system. Its ROM can be extended from 8KB  to 64 KB. It  uses MS-DOS operation system. It 
may also employ 8087 math co-processor. 

PC/XT 

This type of computer contains hard-disk(s) as well as floppy disk drive i.e. 360 KB/1.2 MB. Its cost 
is obviously more than the PC due to additional components. It is also a single-user system. Its ROM 
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can also be extended up to 64 KB. It also normally uses MS-DOS operation system. It may also 
employ 8087 math co-processor. 

PC/AT 

It contains 80286 as CPU, 640 KB RAM (can be expanded to 4 MB), 64 KB ROM (can be expanded 
to 128 KB), hard-disk drive and floppy-disk drive (360 KB/1.2 MB). Microprocessor 80286 is more 
powerful than the microprocessors of  PC and PC/XTs. Up to 4 terminals can be connected to PC/AT 
to make it multi-user system by using XENIX as an operating system. Hard-disk capacity may lie in 
the range 20-80 MB. It uses 80287 math co-processor. Processing speed of PC, PC/XT and PC/AT 
lies in the range 1-5 MIPS. 

Super AT (or Super micros) 

These computers use a 32-bit CPU such as Intel 80386 or 80486. The processing speed of 80386 and 
80496 may range from 3 to 5 MIPS and 12 MIPS at 25 MHz respectively. RAM size of these lie in 
the range 2-8 MB. In case of 80386 microprocessor, it can be extended up to 32 MB and in case of 
80486 up to 64 MB. Hard-disk capacity of these lies in the range 200 MB-780 MB. Normally, UNIX 
is used as a multi-user operating system  on these systems. 80386 CPU offers the connectivity up to 
8-12 terminals whereas 80486 offers the connectivity up to 16-64 terminals.  

Personal computers are available in two models. These are: 

1. Desktop PCs 

2. Tower PCs 

A desktop personal computer is most popular model of personal computer. The system unit of the 
desktop personal computer can lie flat on the desk or table. In desktop personal computer, the monitor 
is usually placed on the system unit. 

Another model of the personal computer is known as tower personal computer. The system unit of the 
tower PC is vertically placed on the desk of table. Usually the system unit of the tower model is 
placed on the floor to make desk space free and user can place other devices such as printer, scanner 
etc. on the desktop. Today computer tables are available which are specially designed for this 
purpose. The tower models are mostly used at homes and offices. 

Microcomputers are further divided into following categories. 

1. Laptop computer 

2. Workstation 

3. Network computer 

4. Handheld computer 

Laptop computer 

Laptop computer is also known as notebook computer. It is small size (85-by-11 inch notebook 
computer and can fit inside a briefcase. The laptop computer is operated on a special battery and it 
does not have to be plugged in like desktop computer. The laptop computer is portable and fully 
functional microcomputer. It is mostly used during journey. It can be used on your lap in an airplane. 
It is because it is referred to as laptop computer. 
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Workstations 

Workstations are special single user computers having the same features as personal computer but 
have the processing speed equivalent to minicomputer or mainframe computer. A workstation 
computer can be fitted on a desktop. Scientists, engineers, architects and graphic designers mostly use 
these computers. 

Workstations use sophisticated display screens featuring high-resolution color graphics and operating 
systems such as UNIX, Windows NT, 95, 98 those permitted multitasking. Workstations also use 
powerful networking links to other computers.  

Most significant feature of workstations is the powerful processor which churns out results much 
faster than the PCs. 

Examples : Sun-, Apollo-, Hewlett-Packard-, NeXT- and IBM-workstations. 

Network Computers  

Network computers are also version of personal computers having less processing power, memory 
and storage. These are specially designed as terminals for network environment. Some types of 
network computers have no storage. The network computers are designed for network, Internet or 
Intranet for data entry or to access data on the network. The network computers depend upon the 
network’s server for data storage and to use software. These computers also use the network’s server 
to perform some processing tasks. 

Handheld Computer 

In the mid 1990s, many new types of small personal computing devices have been introduced and 
these are referred to as handheld computers. These computers are also referred to as Palmtop 
Computers. The handheld computers sometimes called Mini-Notebook Computers. The type of 
computer is named as handheld computer because it can fit in one hand while you can operate it with 
the other hand. Because of its reduced size, the screen of handheld computer is quite small. Similarly 
it also has small keyboard. The handheld computers are preferred by business traveler. Some 
handheld computers have a specialized keyboard. These computers are used by mobile employees, 
such as meter readers and parcel delivery people, whose jobs require them to move from place to 
place. 

The examples of handheld computers are: 

1. Personal Digital Assistants 

2. Cellular telephones 

3. H/PC Pro devices 

Personal Digital Assistants (PDAs) 

The PDA is one of the more popular lightweight mobile devices in use today. A PDA provides 
special functions such as taking notes, organizing telephone numbers and addresses. Most PDAs also 
offer a variety of other application software such as word processing, spreadsheet and games etc. 
Some PDAs include electronic books that enable users to read a book on the PDA’s screen. 

Many PDAs are web-based and users can send/receive e-mails and access the Internet. Similarly, 
some PDAs also provide telephone capabilities. 
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Cellular phones 

A cellular phone is a web-based telephone having features of analog and digital devices. It is also 
referred to as Smart Phone. In addition to basic phone capabilities, a cellular phone also provides the 
functions to receive and send e-mails & faxes and to access the Internet. 

H/PC Pro Devices 

H/PC Pro dive is new development in handheld technology. These systems are larger than PDAs but 
they are not quite as large as typical notebook PCs. These devices have features between PDAs and 
notebook PCs. The H/PC Pro device includes a full-size keyboard but it does not include disk. These 
systems also have RAM with very low storage capacity and slow speed of processor. 

1.9 HUMAN BEINGS VS COMPUTER SYSTEMS 

We have already gone through the anatomy of a digital computer and functioning of a computer 
system using  its various components. Besides, we are  also well versed and aware with the 
functioning of human-beings using its various organs.  

Processing of data by hand is satisfactory only when the amount of data to be processed is small and 
also the manual data processing is slow, monotonous and often subject to error. Human-beings 
utilises past experiences and intuitions for decision making whereas computer follows an algorithmic 
procedure. Human-beings as a decision maker utilises heuristic. Society will benefit most if 
complementary strengths of human beings and computers are utilised. Definitely, computers today 
have more intelligence than in the past and the strides are being made to increase machine 
capabilities. 

The Newell-Simon model suggests that there are limitations on the ability of human as information 
processors : 

* One set of limits concerns the processing of data and is directly related to short-term 
memory 

* Another set of limits is the ability of humans to detect differences 

* Humans are also limited in their ability to generate, integrate, and interpret probabilistic 
data. 

Functional similarities of a computer system with human being is in the following Table 1.2.  

Table 1.2 :Computer Vs. Human-being (Similarities)  

S.NO. COMPUTER 
ELEMENT 

PURPOSE HUMAN-BEING 

1. Input Used to receive data and 
instructions in computer-
compatible form 

Input to the system is 
through ears, eyes, mouth 
or nose 

2. Main Storage Used to hold input data 
and instructions 
temporarily before it is 
processed 

Data and instructions are 
stored in brain and can be 
recalled whenever needed 

3. Secondary Storage Used as an extension to 
main storage and the 

Use pocket-diaries, 
notebooks, etc. to store 
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contents stored in it are 
retained permanently 

contents for permanent 
use. 

4. ALU Used to carry out 
arithmetic and logical 
computations desired in an 
instruction execution 

Portion of our brain is 
used to carry out 
comparisons and 
calculations for helping 
out in logical judgements 

5. Control Unit Used to receive stored 
instructions in serial 
fashion and one at a time. 

Interpret each instruction 
and prompt its execution by 
one of the units like input, 
output, storage or ALU. 

Our brain controls our 
mental or body actions on 
the basis of calculations 
and comparisons.  

Before taking any action, 
the old results stored in 
brain are also referred to 
and thus brain acts as a 
CPU. 

6. Output Used to give out results via 
a suitable device e.g. VDU, 
printer, plotter, etc. 

Output is either in the 
form of a speech using 
mouth or some action e.g. 
writing, gesture, body 
language, etc. 

SUMMARY OF THE LESSON 

You learnt the following in this lesson: 

 A computer is an electronic machine that operates under the control of instructions, that 
accepts the input data, processes or manipulates the given data according to the predefined 
instructions and stores the result for future use. 

 In Dark Age (5000 B.C. - 1890 A.D.), all the computing devices were manual-mechanical in 
nature and all the earliest data processing equipment were all manual-mechanical devices. 

 In Middle Age (1890-1944), all computing devices were electro-mechanical in nature 

 In Modern Age (SINCE 1944), computers changed over time; they improved in speed, power 
and efficiency.  

 The computers can be divided into five generations depending upon the technologies used. 
These generation are:  

o First Generation (1946 – 1959) 

o Second Generation (1959 – 1965) 

o Third Generation (1965 – 1971) 

o Fourth Generation (1971- 1985) 

o Fifth Generation (1985 onwards) 
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 Modern computer systems are available in numerous physical shapes and sizes, and truly 
speaking there is no end to it.  

 The important characteristics of a computer are speed, arithmetical and logical operations, 
accuracy, reliability, storage, retrieving data and programs, automation, versatility, 
communications, diligence, no feelings, consistency and precision 

 Though in general we use digital computers, however, present day computers may be 
classified into three categories – Analog, Digital and Hybrid. 

 Digital computers are computers which represent data in terms of discrete number and 
processes data using the standard arithmetic operations 

 Design features of Analog and Digital computers can be combined to create a Hybrid 
Computer. Such computers are used for special applications only.  

 Depending upon their speed and memory size, computers are classified into four main groups 
– Supercomputer, Mainframe computer, Mini computer and Microcomputer. 

 The examples of handheld computers are Personal Digital Assistants and Cellular telephones. 

 Processing of data by hand is satisfactory only when the amount of data to be processed is 
small and also the manual data processing is slow, monotonous and often subject to error.  

 Human-beings utilises past experiences and intuitions for decision making whereas computer 
follows an algorithmic procedure. Human-beings as a decision maker utilises heuristic.  

SELF ASSESSMENT QUESTIONS AND EXERCISES 

1. What is a Computer? What capabilities does a computer possess?  

2. How do analog computers differ digital computers? 

3. State the criteria for classification of digital computers. 

4. Is digital computer more accurate than analog computer? Justify your answer. 

5. Discuss the important features of micro, mini, mainframes and super-computers. 

6. What are the operations that a computer is able to perform? 

7. How do you compare human beings and computers? 

8. What are the fundamental components of a computer system? Which component of a 
computer system executes the program? 

9. Why are microcomputers so popular in comparison to other computers? 

10. What is a digital computer? Provide its anatomy and explain the functioning of such a 
computer through its block diagram 
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CHAPTER - 2 
INPUT/OUTPUT DEVICES AND OTHER HARDWARE 

OBJECTIVES OF THIS LESSON 

This lesson is aimed to make you understand the basic concepts of peripheral devices as well as 
important hardware components as under: 

 Input/Output concepts 

 Input devices  

o Commonly used input devices such as Keyboards, Mouse, Joysticks, Trackballs, 
Touch Screens, Light Pens, Touch Pad, Digitizer, Voice Systems and Scanners 

 Output devices 

o Commonly used output devices such as Monitors, Printers and Plotters 

 Other important hardware such as - 

o Motherboard, RAM, Video Card, Digital storage, Power Supply Unit, Expansion 
cards, Sound Card, Network card, etc. 

STRUCTURE OF THIS LESSON 

2.1 Introduction 

2.2 Input Devices 

2.2.1 Keyboards 

2.2.2 Mouse 

2.2.3 Joysticks 

2.2.4 Trackballs 

2.2.5 Touch Screens 

2.2.6 Light Pens 

2.2.7 Touch Pad 

2.2.8 Digitizer 

2.2.9    Voice Systems 

2.2.10 Scanners 

2.3. Output Concepts 

2.4 Output Devices 

2.4.1 Monitors 

2.4.2 Printers 

2.4.2.1 Types OF Printers 

2.4.2.2 Character Printers 

Remarks 



Basic of Computers 23 

 

2.4.2.3 Daisy-Wheel Printer  

2.4.2.4 Dot-Matrix Printer 

2.2.4.5  Line Printers 

2.4.2.6 Page Printers 

2.4.2.7 Laser Printer 

2.4.2.8 Inkjet Printer 

2.4.3 Plotter 

2.4.3.1 Drum Plotter 

2.4.3.2 Flatbed Plotter 

2.4.3.3 The Inkjet Plotter 

2.4.3.4 Led Plotter  

2.4.4 Projector 

2.5 Other Hardware 

 

Summary of the Lesson 

Self Assessment Questions and Exercises 

2.1 INTRODUCTION 

A computer peripheral is any external device that provides input and output for the computer. For 
example, a keyboard and mouse are input peripherals, while a monitor and printer are output 
peripherals. Computer peripherals, or peripheral devices, are sometimes called "I/O devices" because 
they provide input and output for the computer. Some peripherals, such as external hard drives, 
provide both input and output for the computer. 

2.2 INPUT DEVICES 

An input device is any hardware device that sends data to the computer, without any input devices, a 
computer would only be a display device and not allow users to interact with it, much like a TV. 
Following continuing research in the field of computer hardware, we have a large number of input 
devices. Recall that before data can be processed by the computer, they must be translated into 
machine-readable form and entered into the computer by an input device. 

Here, we list a variety of input devices: 

 Punched Cards and Card Readers 

 Keyboards 

 Joysticks 

 Trackballs 

 Mouse 

 Touch Screens 

 Light Pens 
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Different types of mouse are shown in Fig. 2.2. 

                           
 

                     (a) Simple Mouse            (b) Cordless Mouse          (c) Ball-point Mouse 

Fig. 2.2: Different Types of Mouse 

Advantages 

 It is simple device and very easy to use. 

 It is not that very expensive. 

 It moves the cursor faster than the arrow keys of keyboard do. 

Disadvantages 

 The movement of the cursor is not very sensitive to movement of mouse. 

 If the contact between wheels and mouse pad is lost, the cursor does not move. 

2.2.3 Joysticks 

A joystick is also a pointing device. It is used to move the cursor position on a CRT screen. Its 
function is similar to a mouse, except that with a mouse the cursor stops moving as soon as you stop 
moving the mouse. A joystick is a stick which has spherical ball at its lower end as well as at its upper 
end. A joystick uses a lever to control the position of the cursor.  It internally translates the lever 
position and speed with which the joystick is moved into digital signals that are sent to the computer 
to control the cursor movement. Most joysticks include two buttons called triggers.  

 
Fig. 2.3: Joystick 

Joysticks are used for Computer games but they are also used occasionally for CAD/CAM systems 
and other applications. 

2.2.4 Trackballs 

Trackball is another pointing device. A trackball is a mouse lying on its back. A trackball uses a hard 
sphere to control cursor movement. The ball can be rotated by hand in any direction. The associated 
electronic circuitry detects the direction and speed of spin. The trackball translates the sphere's 
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Light pens are shown in Fig. 2.6. 

 
Fig. 2.6: Light Pens 

2.2.7 Touch Pad 

A small, touch-sensitive pad is used as a pointing device on some portable computers. By moving a 
finger or other object along the pad, we can move the pointer on the display screen. The touch pad is 
related to the touch screen, but activated by different means. The touch pad uses pressure-sensitive 
materials to record data at the point where the pad is touched.  Many  appliances around  the  home,  
such  as  microwave  ovens,  use  touch  pads  for programming time or temperature. 

 
Fig. 2.7: Touch Pad Using a Point-device 

2.2.8 Digitizer 

A digitizer, or graphics  tablet,  is  similar  to  a  light  pen; however, instead of drawing on the screen, 
a separate tablet  is  used on which a special stylus is  moved.  Input tablets or digitizer tablets or 
graphical tablets are typically found in CAD terminals or engineering workstations, etc.  

Digitizers are also called Digitizing Tablets, Graphics Tablets, Touch Tablets, or simply Tablets. Top-
view of digitizer along with tablet is shown in Fig. 2.8. 
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(c)      (d) 

(a) to (c)  Flatbed Scanners      (d) Hand-held Scanner 

Fig. 2.9: Types of Scanners 

2.3. OUTPUT CONCEPTS 

The output devices receive results and other information from the computer and provide it to the 
users. Output is the process of translating data in machine-readable form into a form understandable 
to humans or readable by other machines.  

In today's information society, people require clear, legible and output. Output that can be understood 
by humans can be categorized as: 

 Hard copy   

 Soft copy 

Hard  copy  is  the  output,  such  as  paper,  that  can  be  read immediately or stored and read later.  
It is relatively stable and permanent form of output. Soft copy is usually a screen-displayed output. It 
is transient form of output and is lost when the computer is turned off. But if the data needed to create 
the soft copy have been saved on disk or tapes, the soft copy can be reproduced on the screen 
anytime. 

2.4 OUTPUT DEVICES 

Any peripheral that receives or displays output from a computer. An inkjet printer is a good example 
of an output device that can make a hard copy of anything on a computer. Below is a listing of all the 
different computer output devices found on a computer: 

 Flat panel 

 Monitor 

 Printer 

 Projector 

 Sound card 

 Speakers 

 Video card 

Remarks 



30 I/O Devices & Other Hardware 

 

An output device is any piece of computer hardware equipment used to communicate the results of 
data processing carried out by an information processing system (such as a computer) to the outside 
world. 

Examples of output devices: 

 Monitors 

 Printers 

 Plotters 

 Speakers 

 Headphones 

 Voice Response Systems 

Most of the computer output devices are common to home as well as office environments. At the 
same time, there are some devices, which are not as commonly available. Having said that, let’s take 
a look at computer output devices list. 

2.4.1 Monitors 

A computer display is also called a display screen or video display terminal (VDT). A monitor is a 
screen used to display the output. Images are represented on monitors by individual dots called pixels. 
A pixel is the smallest unit on the screen that can be turned on and off or made different shades. The 
density of the dots determines the clarity of the images, the resolution.  

Types of Computer Monitors 

The computer monitor (also known as a VDU or Visual Display Unit) is the most common computer 
output device.  For desktop computers, cathode ray monitors (CRT) are gradually being replaced by 
flat-screen monitors such as the Liquid Crystal Displays (LCD) and Thin Film Transistor (TFT) 
displays used with laptop computers because they use less power and take up less space.  

2.4.2 Printers 

A printer is a peripheral which produces a text and/or graphics of documents stored in electronic 
form, usually on physical print media such as paper or transparencies. Many printers are primarily 
used as local peripherals, and are attached by a printer cable or, in most new printers, a USB cable to 
a computer which serves as a document source. Some printers, commonly known as network 
printers, have built-in network interfaces, typically wireless and/or Ethernet based, and can serve as a 
hard copy device for any user on the network. Individual printers are often designed to support both 
local and network connected users at the same time. There are several printer technologies, the most 
common of which are:  

 the daisy wheel printer 

 the dot-matrix printer (also called impact matrix printer) 

 the inkjet printer and the bubble jet printer 

 the laser printer 

Today, daisy wheel printers and matrix printers are hardly ever used.  
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2.4.2.1 Types of Printers 

A printer is an output device that produces a hard copy of data. The resolution of printer output is 
expressed as DPI. Printers can be classified into different types in several ways.  

First, the printers can be divided into three categories by the way they print.  

 Serial Printers: Also called a character printer. Print a single character at a time. They are 
usually inexpensive and slow.  

 Line Printers: Print a line at a time. They are expensive and very fast. Line printers use a 
band, a chain, etc.  

 Page Printers: Also called a laser printer. Print a page at a time. They usually use a laser to 
produce page images. Quality is best. This is a little bit expensive, but the price of the 
personal laser printer is decreasing. The price range of the personal laser printer is around 
$400, today.  

Second, printers can be classified into two forms according to the use of a hammer.  

 Impact Printers: Hammer hits ribbons, papers or print head. Dot-matrix and daisy-wheel 
printers are the example. Noisy.  

 Nonimpact Printers: They do not have the hammer and do not hit. An example is an ink-jet 
and laser printer.  

So, let's take a closer look at the various types of printers. 

2.4.2.2  Character Printers 

They are used to print only one character at a time. A typewriter is an example of a character printer. 
Some of character printers are described below. 

2.4.2.3  Daisy-Wheel Printer  

Daisy-Wheel Printer prints typewriter-like very high quality characters. However, they are slower and 
less reliable than dot-matrix printers. Microcomputer users seldom use this printer, because the better 
dot-matrix printers and inexpensive laser printers are available today. The speeds of daisy-wheel 
printers range from 30 to 60 characters per second (cps).  

 
Figure 2.14: A daisy-wheel print wheel 

2.4.2.4  Dot-Matrix Printer 

The dot-matrix printer allows you to print documents on paper thanks to the "back and forth" 
motion of a carriage housing a print head.  
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 The computer monitor (also know as a VDU or Visual Display Unit) is the most common 
computer output device. 

 A printer is a peripheral which produces a text and/or graphics of documents stored in 
electronic form, usually on physical print media such as paper or transparencies. 

 A printer is an output device that produces a hard copy of data. The resolution of printer 
output is expressed as DPI. Printers can be classified into different types in several ways.  

 Plotters were the first type of printer that could print with color and render graphics and full-
size engineering drawings.  

 Computer hardware is the collection of physical parts of a computer system. Apart from 
computer case, monitor, keyboard, mouse, printers, plotters, etc., it also includes all the parts 
inside the computer case, such as the hard disk drive, motherboard, video card, and many 
others.  

SELF ASSESSMENT QUESTIONS AND EXERCISES 

1. What are input devices? 

2. What do you mean by keyboard? 

3. Explain the concept of mouse? 

4. Explain the speech recognition system in detail? 

5. What do you mean by digital camera? 

6. Explain the working of scanners? 

7. What do you mean by output devices? 

8. What are printers? Explain the various types of printers in detail? 

9. Explain the various types of plotters? 

10. What do you mean by monitor? 

11. Explain the various types of monitors? 

12. What do you mean by projector? 

13. State the necessities of Input and Output devices. 

14. What are the reasons for the visual display unit to be more popular than punched card reader? 

15. What is a Keyboard? How does a simple keyboard differ from an ergonomically designed 
keyboard?  
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CHAPTER - 3 
 

WINDOWS OPERATING SYSTEM 
 

OBJECTIVES OF THIS LESSON 

This lesson is aimed to make you understand the basic concepts of windows. Readers will be able to 
understand the following: 

 Windows operating system, its common features, Windows Explorer. 

 Control Panel, Print Manager and other elements of Windows GUI 

STRUCTURE OF THIS LESSON 

3.1 Windows Operating System 

3.1.1 Common Features of Windows GUI 

3.1.2 Windows Explorer 

3.1.3 Print Manager and Installing Printers 

3.1.4 Control Panel 

3.1.5 Using Paint Brush 

3.1.6 Using Clipboard in Windows 

3.1.7 My Computer 

 

Summary of the Lesson 

Self Assessment Questions and Exercises 

 

3.1 WINDOWS OPERATING SYSTEM 

Microsoft Windows (or simply Windows) is a meta family of graphical operating systems 
developed, marketed, and sold by Microsoft. It consists of several families of operating systems, each 
of which cater to a certain sector of the computing industry.  

The Windows operating system is developed and maintained by Microsoft, the company founded by 
Bill Gates. The first version was released in 1985. Since then, it has grown significantly, and it now 
dominates the market. Windows uses a graphical user interface to make it easier for people to use 
their computers. The primary ways that people navigate are through icons on the desktop and the Start 
menu.  

As of April 2014, the most recent versions of Windows for personal computers, smartphones, server 
computers and embedded devices are respectively Windows 8.1, Windows Phone 8.1, Windows 
Server 2012 R2 and Windows Embedded 8. A specialized version of Windows runs on the Xbox 
One game console. 
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The next version of Windows is Windows 10 and is currently available as a technical preview; it is 
set for release for phones, tablets, laptops, and PCs in late 2015. 

However, versions of Windows operating system with its date of release are provided in Table 3.1. 

Table 3.1: Windows Operating System Versions 

Date Version 
1981 Sept. Interface Manager 
1983 Windows was announced 
1985 Nov. Windows 1.0 for 8088 CPUs released 
1987 Dec. Windows 2.0 for 386 CPUs, up to 16 mbyte RAM addressable 
1988/89 Windows 2.1 for 286/386 
1990 Windows 3.0 
1992 April 3.1 (janus) includes MS-DOS 5.0 
1993 Nov. Windows for Workgroups 3.11 (snowball) rudimentarily networkable 
1995 Aug. Windows 95 4.0 Codename "Chicago" was released 
1996 Feb. Windows 95 Version A (OSR1) 
1996 Aug. Windows 95 (detroit) Version B (OSR2) first time with FAT-32 support 
1997 April Windows 95 Version B (OSR2.1) 
1997 Nov. Windows 95 Version C (OSR2.5) 
1998 June Windows 98 (memphis) about 5,000 bugs fixed 
1999 May Windows 98 SE (Second Edition) 
2000 Sept. Windows Me (Millenium) 
1980 Aug. XENIX OS cooperation with SCO 
1982 Feb. XENIX 2.3 cooperation with SCO 
1983 April XENIX 3.0 cooperation with SCO 
1987 MS OS/2 1.0 cooperation with IBM 
1988 OS/2 1.1 cooperation with IBM 
1991 OS/2 1.3 cooperation with IBM 
1992 OS/2 2.0 cooperation with IBM 

1993 July Windows NT 3.1 & Advanced Server; 3.1 million lines of source code, 
supports HPFS 

1994 Sept. Windows NT 3.5 (daytona), Workstation and Server, with opengl and 
Netware client; 9 million lines of source code 

1995 May Windows NT 3.51, updae, transparent compression with NTFS file 
system, PCMCIA support, for Power-PCs available too 

1996 Aug. Windows NT 4.0 (cairo) 16 million lines of source code, no support for 
HPFS anymore 

1996 Windows NT Terminal Server Edition (hydra) 
1997 Windows NT Server 4.0 Enterprise Edition 
1998 Windows NT Server 4.0 Terminal Server Edition 

2000 Feb. Windows 2000, Windows version 5.0; 30 million lines of source code, 
about 10,000 bugs fixed 
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d) Resizing and Movement : Windows system also support resizing as well as moving around 
feature of windows. 

e) Graphical Bit-mapped Displays : Bit-mapped display are made up of small pixels and offer a 
very high resolution. Bit-mapped displays have almost replaced character-based displays. Bit-
mapped displays wonderful support graphic manipulation. This feature of these displays is  
also called WYSIWYG i.e. What You See Is What You Get. 

f) Functionality to support graphics along with height-parameters, color attributes, video-
attributes, etc. 

g) Icon : Icons provide a symbolic representation of any system-entity or user-defined object, 
etc.  such as file, folder, address, table, book, applications and so on. A folder icon consists a 
group of files or other folder icons. Double clicking on the folder icon causes a window to be 
opened displaying a list of icons and folder icons representing the folder's contents. 

h) Dialog box : Dialog box is used  to capture user information  or to present information to the 
user. Normally, a dialog box is displayed to get additional information. Dialog boxes are also 
used to indicate error messages in the form of alert boxes. Dialog boxes also use a wide range 
of screen control elements to communicate with the user. 

i) Check box : Such a box is used to capture the information intending confirmation pertaining 
to any kind of actions desired by the end-user.  

j) Sliders : These are used to show the relative position of the contents or to move to a different 
position. 

k) Desktop Metaphors : In desktop graphical metaphor, users are not aware of applications and 
they deal with files, folder, drawers, clipboard and an out-box. For example, merely clicking 
the mouse on an icon representing the Report cause word processor to get started and to load 
the report file automatically.  

l) Menus : The functionality on a GUI system must be arranged in the form of structured menus 
such as horizontal menus, pull-down menus, etc. From the menu, the end-user can select any 
operation of his choice such as File, Edit, Search, Tool and so on. Rather than remembering 
commands at each stage, a menu can be used to provide a list of items. Each menu element 
can be either a word or an icon representing a command or a function. Menu item can be 
invoked by moving the cursor on the menu item and selecting the item by clicking the mouse. 

3.1.2 Windows Explorer 

Windows Explorer displays the hierarchical structure of files, folders, and drives on your computer. It 
also shows any network drives that have been mapped to drive letters on your computer.  

Windows Explorer is automatically launched any time you open a folder in Windows XP. 

Using Windows Explorer, you can copy, move, rename, and search for files and folders. For example, 
you can open a folder that contains a file you want to copy or move, and then drag the file to another 
folder or drive. 
There are other places in Windows where you can view and work with files and folders. My 
Documents is a convenient place to store documents, graphics, or other files you want to access 
quickly.  
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When you paste the contents of the Clipboard, the contents remains available for further pasting 
operations. It is overwritten only when you copy or cut something else. 

What Can You Copy to the Clipboard? 

Just about anything that can be selected in Windows: text of all kinds, graphics, files (including 
shortcuts) or folders. 

What Can You Paste from the Clipboard? 

Pasting the contents of the Clipboard depends on where you want to perform the paste. For example, 
if you are working with text, you can paste text only in apps and programs that work with text. 
Following the same rule, you can paste graphics only in apps and programs that work with graphics, 
and so on. 

If the contents of the Clipboard cannot be pasted where you want to, it will not be pasted there but the 
contents of the Clipboard will remain intact. 

How to Manage the Clipboard in Windows? 

Windows XP had a Clipboard Viewer that allowed users to view the contents of the local clipboard, 
clear the clipboard or save copied and cut items. 

Unfortunately, this program was removed from Windows Vista and subsequent versions of Windows, 
including Windows 8.1. 

Therefore, if you want to view the contents of the clipboard and manage it, you must use third-party 
programs developed by companies other than Microsoft.  

Windows XP had clipbrd.exe, referred to as the Clipboard Viewer or the ClipBook Viewer, which 
could be used to see what was saved on your clipboard. If you try to search for this exe file in 
Windows Vista, Windows 7 or Windows 8, you will be unable to find clipbrd.exe. 

Clipboard in Windows 7 / 8 

In Windows XP this file was situated in C:\Windows\System32\clipbrd.exe. It is now missing as a 
part of the Windows 7 | 8 installation. You can try to copy it from a Windows XP installation, if you 
have access to it, and paste it in your System32 folder. In most cases this is known to work. 

Clipboard Viewer 

If you wish, you can download Windows Clipboard Viewer but if it does not work or if you are 
confronted with a message of sorts: Entry Point Not Found, then you may try to run it in Windows 
XP/SP2 compatibility mode and see if it works. 

The Windows Clipboard is very basic in nature and does not offer many features. As a result, many 
free Clipboard alternatives like ArchiveClipboard, Enhanced Clipboard Manager, CopyCat, 
Clipboardic, Orange Note, Ditto, Clipboard Magic, etc, are available on the Internet. 

3.1.7 My Computer 

The ‘My Computer’ icon gives us easy access to our hard drives, removable flash drives and other 
network-related locations. But if you’re one who enjoys a clutter-free desktop, then maybe you can 
use this tweak to remove the many program and folder shortcuts on your desktop. 
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 In Windows and other operating systems, the Clipboard is a short-term storage area for all 
kinds of information that you have copied from one place and you plan to use in another 
place.  

 The ‘My Computer’ icon gives us easy access to our hard drives, removable flash drives and 
other network-related locations.  

SELF ASSESSMENT QUESTIONS AND EXERCISES 

1.  What is an operating system? 

2.  Discuss the important functions of an operating system. 

3.  What is a File Manager? Outline its responsibilities. 

4.  Chart the family of operating system. 

5.  What is Windows operating system? List its important versions. 

6.  What is the purpose of a clipboard? 

7.  What is Print Manager? 

8.  What is ‘My Computer’?  

9.  What is Paint program/Paint Brush? 

10.  What are main features of Windows operating system? 

11.  What is Control Panel? How is it useful? 
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CHAPTER – 4 
 

INTRODUCTION TO MICROSOFT WORD 
 

OBJECTIVES OF THIS LESSON 

This lesson is aimed to make you understand the concepts of word processing and MS-Word. Readers 
will be able to understand the following: 

 Concept and features of word processing 

 Basic concepts of MS-Word 

 Different components of Word document window 

 Different types of Menu and their various options 

 Various types of Toolbars with their different options 

 Use of Ruler to set the margins of document 

 Scrolling of document with the help of Scroll bar 

 To check the spelling and grammar mistakes of text of document 

 Creating, editing and saving of document by various ways. 

STRUCTURE OF THIS LESSON 

4.1 Introduction 
4.2  Word Processor 
4.3  Ms-Word 
4.4  Features of Ms-Word 
4.5  Components of Word Document Window 
4.6 Menu Bar 
 4.6.1 File Menu 
 4.6.2 Edit Menu 
 4.6.3 View Menu 
 4.6.4 Insert Menu 
 4.6.5 Format Menu 
 4.6.6 Tools Menu 
 4.6.7 Table Menu 
 4.6.8 Window Menu 
 4.6.9 Help Menu 
4.7 Toolbars 
 4.7.1 Standard Toolbar 
 4.7.2 Format Toolbar 
 4.7.3 Drawing Toolbar 
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4.8 Scroll Bar 
4.9 Ruler 
4.10  Creating a Document 
 4.10.1 Creating a New Document 
 4.10.2 Opening a Saved Document 
 4.10.3 Closing a Document 
4.11  Editing and Formatting A Document 
 4.11.1 Editing Text 
 4.11.2  Undo and Redo   

  4.11.3 Cut, Copy and Paste 
  4.11.4 Clear Formatting 
  4.11.5 Find and Replace 
 4.11.6 Go To 
  4.11.7 Character Formatting 

 4.11.8 Bullets or numbering 
 4.11.9 Other Formatting Features 
  4.11.10 Paragraph Alignment 
 4.11.11 Spelling Check 
4.12  Saving a Document 

  Summary of the Lesson 

   Self Assessment Questions and Exercises 

4.1 INTRODUCTION 

There are many ways of conveying information. Writing is one of them. Earlier we were using 
manual typewriters to prepare documents, then electronic typewriters and now we are using 
computers to prepare any type of document. Many applications programs have been developed that 
helps us to quickly create documents with a professional look. One such most popular program is 
word processor. A word processor provides general tools for creating, editing, saving, formatting and 
printing the documents. We can create all types of documents that are used in our daily lives with the 
help of word processor. In fact word processor provides a great role in every field for creating 
different types of documents. Therefore, it is suggested generally that every person must be aware of 
word processing and its features. 

4.2 WORD PROCESSOR 

Word processor is software that enables us to create, edit, save and print the documents. With the help 
of this, users can make their document more effectively by combining text, graphics and images. 
There are number of word processors such as MS-Word, Word Star, Write, Word Perfect, Chi Writer 
etc. The most popular and commonly used word processor is MS-Word. 

4.3 MICROSOFT WORD (MS-WORD) 

Microsoft word is the most popular and commonly used word processor. It is used to create different 
types of documents such as letter, reports, memos, invoices, proposals etc. MS-Word is used to save, 
edit and print the document. With the help of different toolbars, we can make the document attractive 
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To open the document on a specific template or to use a wizard, type or select the name of the 
template or wizard in the template box. It no template is selected, MS-Word uses the Normal 
Template. MS-Word gives a temporary name to new document that will visible in the title bar, until 
you save it with a unique name of your choice. 

Entering Text 

When you create the new document, the blinking insertion point inside the document window shows 
your current position.  The text you type will be appeared at current position. 

4.10.2    Opening a Saved Document 

 The steps to open a saved document are: 

1. Go to file menu. A dialog box will appear. 

2. Click on open option and choose the desired document you want to open. From the open 
dialog box, open document by double clicking on it or type file name and click open button. 

Shortcut:  To open the open dialog box, press Ctrl + O 

4.10.3 Closing a Document 

 The steps to close a document are:  

       1. Go to file menu and press close. 

       2.   In case, you forgot to save your file, before closing, a message box will appear. 

       3. Click Yes button, if you wish to save the changes or click No button, if you do not wish  to 
save the changes. 

  Or 

 To close a document in MS-Word, click on the close button on the top right corner of the 
 Menu Bar. If the document has not been saved, a prompt box appears. Click on the Yes 
 button to save the changes or No button, if you do not wish to save the changes. 

Shortcut:  for closing a current file is Ctrl + W. 

4.11 EDITING AND FORMATTING A DOCUMENT 

After creating and saving a document, you may need modifications in the document. For instance, 
you may like to add text at a particular location or you may like to move a  paragraph from one page 
to another or delete a portion of the text. Making modification in a document is called editing. Editing 
is the process of changing the appearance of the text, deleting a portion of the text or moving a part of 
the text. It is necessary to select the text before move, format, delete or changing text. Text can be 
selected with the help of mouse or keyboard. It is very easy to select the text with the help of mouse 
as compared to keyboard. The mouse methods for selecting the text are following:  

1. Select a word- To select a word, double click the word. 

2. Select the line- To select a line you can select with the help of mouse or by placing a cursor on the 
left side and then press shift + end for selecting the whole line at once. 

3. Select the sentence – Sentence can be selected by hold down ctrl key and click anywhere in 
sentences. 
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 Numbered list and Bulleted list add importance to a list of points in a document. 

 Find is used to find text, select Edit > Find. 

 Replace is used to replace a text, select Edit > Replace. 

SELF ASSESSMENT QUESTIONS AND EXERCISES 

1. What do you mean by Word Processor? How it is useful? 

2. Discuss the components of Word Document Window.  

3. What is the use of title bar? 

4. What is the purpose of standard toolbar? 

5. What is the purpose of formatting toolbar? 

6. Write down the steps to create a document. 

7. Discuss various ways and steps to save a document. 

8. Discuss the steps to close document. 

9. What is editing? Explain various commands used for editing. 

10. Write the steps to find and replace text from the document 

11. What is the purpose of undo and redo? 

12. State the steps to cut and copy the text. 

13. How can you find out the text available in document? 

14. Explain various option of help menu. 

15. State the steps to align text. 

16. Explain the steps to change the font and font size by giving example. 

17. What will you do to save a document 

18. How will you start the MS Word to create your document? 

19. What are the shortcut keys for cut, copy and paste? 

20. What do you understand by text wrapping 
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CHAPTER - 5 

   
ADVANCED FEATURES OF MICROSOFT WORD 

OBJECTIVES OF THIS LESSON 

In addition to the basic features described in the previous chapter, MS-Word also provides very useful 
additional features such as Import, Export, Frame, Table, Mail-merge, Macros etc. These advanced 
features are discussed in this chapter. Readers will be able to understand and used the following 
advanced features of MS-Word: 

 Import and Export  
 Working with Frames  
 Multi column specification of a document 
 Various ways to insert the pictures in Word document 
 Creating and formatting of table 
 Macro and its uses 
 Mail Merge 

STRUCTURE OF THIS LESSON 

5.1 Introduction 
5.2  Importing, Exporting and Inserting Pictures  
 5.2.1 Importing Clip Art Images 
 5.2.2 Importing Graphics from Other Files 
 5.2.3 Export Data from Ms Word 
5.3  Working with Frames 
5.4  Columns  
 5.4.1 Creating Multi-Column Documents 
5.5  Picture  
 5.5.1 Inserting a Picture Using Clip-Art  

 5.5.2 Inserting a Picture From File 
 5.5.3 Inserting a Picture from Scanner or Camera 
 5.5.4 Drawing Objects in a Document 
 5.5.5 Inserting Autoshapes 
 5.5.6 Inserting a Picture Using Word Art 
 5.5.7 Inserting a Chart 
5.6  Create a Table 
 5.6.1 Inserting Row and Column in Existing Table 
 5.6.2 Delete a Table 
 5.6.3 Delete Row or Column 

 5.6.4 Change the Column Width in a Table 
  5.6.5 Change the Row Height in a Table  

 5.6.6 Autofit 
 5.6.7 Sorting Text in Table 
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 5.6.8 Formatting Text in Table 
 5.6.9 Formatting of Table 

5.7 Macros 
 5.7.1 Recording a Macro  
  5.7.2 Running a Macro 

5.8 Mail Merge 
5.9  Shortcut Keys 
  Summary of the Lesson 
   Self Assessment Questions and Exercises 

5.1 INTRODUCTION 

MS-Word is a powerful word-processing tool. Apart from common features, MS-Word also provides 
very useful advanced features such as Import, Export, Frame, Table, Mail-Merge, Macros etc. These 
advanced features are quite helpful and are discussed in this chapter. 

5.2 IMPORTING, EXPORTING AND INSERTING PICTURES 

MS-Word can directly import graphics file created in most of the common graphics file formats. For 
example if you create a drawing in Paint, AutoCAD or CorelDraw and want to show it in your word 
document, you can insert it very easily. Some of the common graphics file formats that MS-Word can 
use are given as:  

1. Windows Metafile (.WMF) 

2. Enhance Metafile (.EMF) 

3. JPEG File Interchange Format (.JPG) 

4. Kodak Photo CD (.PCD) 

5. PC Paintbrush (.PCX) 

6. Windows Bitmap (.BMP) etc. 

Graphics can be imported either from other applications by using picture objects command from 
insert menu or copy a graphics from other file and paste in document. 

5.2.1  Importing Clip Art Images 

Word includes a number of Clip Art images that you can include in your document. For instance, it 
has Clip Art files for an anchor, dinner, animals, office equipment etc. To insert any graphics file in 
your document, use the insert, picture command  

To insert the clip art at any desired position of the text follow the following steps: 

1. Position the insertion point where you want to insert the graphics  

2. From insert menu choose picture and then choose clip art 

3. A dialog box will appear on your screen from which you can select image. 

4. Select the image that you want to import in your document. 
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Ctrl+J  Justify the selected paragraph  

Ctrl+K  Insert a hyperlink within the selected text  

Ctrl+Shift+K  Format select text as small caps  

Ctrl+L  Left align the selected paragraph  

Ctrl+M  Indent the selected paragraph from the left  

Ctrl+Q  Remove paragraph formatting from selected paragraph  

Ctrl+R  Right align the selected paragraph  

Ctrl+T  Apply a hanging indent to the selected paragraph  

Ctrl+U  Underline the selected text  

Ctrl+Shift+D  Double-underline the selected text  

Ctrl+Shift+W  Underline the selected words but not spaces  

Ctrl+V  Paste cut/copied text or object  

Ctrl+Shift+V  Paste copied format  

Ctrl+0  Add/Remove one line space before the selected paragraph  

Ctrl+1  Apply single-space lines to the selected text  

Ctrl+2  Apply double-space lines to the selected text  

Ctrl+5  Apply 1.5-space lines to the selected text  

Ctrl+Spacebar  Remove selected text's manual character formatting  

 

Shortcut  Function  

Ctrl+Equal Sign  Subscript the selected text  

Ctrl+Shift+Plus 
Sign  

Superscript the selected text  

Ctrl+Shift+Q  Apply Symbol font to the selected text  

Ctrl+Shift+F  Change the selected text's font  

Ctrl+Shift+P  Change the selected text's font size  

Ctrl+Shift+>  Increase the selected text's font size by one point  

Ctrl+Shift+<  Decrease the selected text's font size by one point  

Ctrl+]  Increase the selected text's font size by one point  

Ctrl+[  Decrease the selected text's font size by one point  

Shift+Enter  Insert a line break  

Ctrl+Enter  Insert a page break  

Remarks 



104 Advanced Features of Microsoft Word 

 

Ctrl+Shift+Enter  Insert a section break  

Alt+Ctrl+Minus 
Sign  

Insert an em dash  

Ctrl+Minus Sign  Insert an en dash  

Ctrl+Hyphen  Insert an optional hyphen  

Ctrl+Shift+Hyphen  Insert a nonbreaking hyphen  

Ctrl+Shift+spacebar  Insert a nonbreaking space  

Alt+Ctrl+C  Insert the copyright symbol  

Alt+Ctrl+R  Insert the registered trademark symbol  

Alt+Ctrl+Period  Insert and ellipsis  
 

Shortcut  Function  

Alt+Ctrl+K  Enable AutoFormat  

Ctrl+Shift+L  Apply the List style to the selected text  

Ctrl+Shift+N  Apply the Normal style to the selected text  

Ctrl+Shift+S  Apply a style to the selected text  

Alt+Ctrl+1  Apply the Heading 1 style to the selected text  

Alt+Ctrl+2  Apply the Heading 2 style to the selected text  

Alt+Ctrl+3  Apply the Heading 3 style to the selected text  

Tab  Move to next cell in a row; Start a new row if pressed within a row's 
last cell  

Shift+Tab  Move to previous cell in a row  

Alt+Home  Move to the first cell in a row  

Alt+End  Move to the last cell in a row  

Alt+Page Up  Move to the first cell in a column  

Alt+Page Down  Move to the last cell in a column  

Up Arrow  Move to the previous row  

Down Arrow  Move to the next row  

Enter  Start a new paragraph within a cell  

Ctrl+Tab  Insert a tab within a cell 

Ctrl+N  Open a new document that is the same type as the current or most 
recently opened document  

Ctrl+O  Display the File | Open dialog box  
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Ctrl+W  Close the current document  

Ctrl+S  Save the current document  

Alt+Ctrl+S  Split the document window  

Alt+Shift+C  Remove the document window split  

F1  Display Word Help dialog box  

Shift+F1  Open Reveal formatting dialog box or open context-sensitive Word Help  

F2  Move selected text of object  

Shift+F2  Copy the selected text  

F3  Insert AutoText  

Shift+F3  Change the case of the selected text  

F4  Repeat last action  

Shift+F4  Repeat Find or Go To  

F5  Display the Edit | Go To dialog box  

Shift+F5  Move to the last change  

F6  Move to the next pane or frame  

Shift+F6  Move to the previous pane or frame  

F7  Display Tools | Spelling and Grammar dialog box  

Shift+F7  Display the Tools | Language | Thesaurus dialog box  

F8  Extend the selection  

Shift+F8  Shrink the selection  

F9  Update the selected fields  

Shift+F9  Switch between a field code and its product  

F10  Activate the Word menu bar  

Shift+F10  Display the shortcut menu  

F11  Move to the next field  

Shift+F11  Move to the previous field  

F12  Display the File | Save As dialog box  

Shift+F12  Save the current document  
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SUMMARY OF THE LESSON 

 

You learnt the following in this lesson: 

 Data can be exported/ imported in MS-Word. 

 In MS-Word, pictures can be inserted by various ways such as using AutoShapes, ClipArt, 
From Files, from scanner and Camera etc. 

 Multi-Column facility makes more than one column in single document. 

 With the help of spell check option, we can make error free document. 

 To create a table, select Table > Insert > Table 

 You can enter data in a cell of a table by clicking in it. 

 To insert rows / columns select, Table > Insert 

 To merge cells, select Table > Merge Cells 

 A macro is a series of word commands and instructions that is used as group together as a 
single command. Word macros can help save time by automating repetitive tasks. Macro is 
used to edit and format the document. 

 Mail merge is used to send same letter to different recipients. 

SELF ASSESSMENT QUESTIONS AND EXERCISES 

1. Discuss the steps of import and export in MS Word. 

2. What is the use of Frame? How a frame can be created? 

3. Discuss Table- handling in MS-Word. 

4. How multi-column document can be created? 

5. What are the steps for recording and running of a macro? 

6. Discuss various ways to insert picture in a document.  

7. How a table can be created? 

8. What are the steps to insert row and column in a table? 

9. How can you format text in a table?  

10. How will you insert an Autoshape in your document? Explain. 

11. What is Clip Art gallery?  

12. Inserting a table in your document saves a lots of time, how? Explain. 

13. What is the difference between clip art and word art? 

14. What do you mean by macro? 

15. What is the purpose of Mail merge? 

16. How can you create and use a macro? 

17. Describe the concept of Mail merge by giving suitable example. 
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